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TS24 PROFESSIONAL
CAU HINH cO BAN DE SU DUNG PHAN MEM

Gidi thiéu:
N6i dung nay hudng dan cho ngudi diing cu hinh mdt s6 chlrc ndng co ban trén may tinh dé cé
thé cai dat va sir dung phan mém TS24 Professional.

1. Kiém tra ciu hinh may tinh:

PE& kiém tra yéu cau cdu hinh mdy tinh tir phia nha cung cdp TS24, ngudi dung truy cdp vao
website TS24.com.vn > trén thanh tiéu dé chon “Tai vé” > tham khao phan ndi dung “Yéu cau hé
thong”.
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Théng tin co ban vé ng dung TS24pro
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Diém ndi bat Yéu cau hé thong Phan mém ho tro
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D& kiém tra ciu hinh may tinh dang s dung c6 phl hdp véi yéu cau nay hay chua, trén ban phim
ngudi dung nhan chon t6 hgp phim “Windows + R” dé md& clra s6 “Run”.
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Nhap Iénh “dxdiag” vao 6 “Open” > nhap chon “OK".

rE'Run ﬂ

===  Type the name of a program, folder, document, or Internet
resource, and Windows will open it for you.

Qpen: | T v

%' This task will be created with administrative privileges.

| OK | Cancel J[ Browse... J

—

Clra s6 mdi xuét hién cung cap théng tin vé hé théng clia may tinh ngudi dung, kiém tra trong tab
“System”, bang “System Information” dé biét dugc cau hinh may tinh dang hoat déng, tir dé doi
chiéu véi yéu cau mac dinh ctia nha cung cap phan mém TS24 xem cd tuang thich dé co thé cai dat
va st dung phan mém dugc hay khéng.

[ € Directx Diagnostic Tool [E=gE)

m[s«.m]s«mz]m

This tool reports detaled information about the DirectX components and drivers installed on your system.

If you know what area is causing the problem, dick the appropriate tab above. Otherwise, you can use the Next Page” button below to
visit each page in sequence.

System Information

Current Date/Time: Wednesday, September 09, 2015, 5:18:39 PM

C ter Name: TS2 ANTH
Operating System: Windows 7 Ultmate 32-bit (6. 1, Buld 7601) |

Language: Engish (Regional Setting: Engish)
System Manufacturer: System manufacturer
M System Model: System Product Name

= 00 14
ES700 @ 3.00GHz (2 CPUS), ~3.0GHz l

Processor: Pentium(R) Dual-Core CPU
Memory: 2048MB RAM

Poge fle: 3315V Used, 707V avalobie

DirectX Version: DirectX 11

Check for WHQL digital signatures;

DxDiag 6.01.7601.17514 32-bit Unicode Copyright © 1998-2006 Microsoft Corporation. All rights reserved.

[ Hep [ NetPoge ][ SoveAlifomaton... | | Ext ]
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M3 clra s6 "My Computer” > nh3p chudt phai vao biéu tugng & dia C > chon “Properties” d&
kiém tra dung Iugng 6 dia cling clia mdy tinh, khi cai d&t phan mém TS24Pro ngudi dung nén méc
dinh cai dat trén 0 dia C, dung lugng 6 cling con trong tdi thiéu 2GB trd Ién.

Organize v &) SN Checkout... Map network drive Open Control Panel
R | @ TortoisesVN »
4 5¢ Favorites ves (3)
B Desktop ‘ Restore previous versions U (C) DATAL (D) DATA2 (€)
Download Add to archive... b — T — =

szm‘ Add to "Archive.rar” free of 68.3 GB v 315 GB free of 878 GB v 134 GB free of 766 GB
B Compress and email... Removable Storage (1)
44 libraries | @8 Compress to "Archiverar” and email
N Y SO ) bt Deive (F:)

Format...

Copy tion (1)

Rename ft (\\192.168.0.110\ts24corp)
New

Properties

—

> ca DATAL (D)
> ca DATA2 (E)
> G Support (\\192.168.0.110\ts24corp) (Ne)

> € Network

TS24 : | TS24-QUANTH Domain: TS4CORP.COM Memory: 200 GB
professior Processor: Pentium(R) Dual-Core ..

X Favorites 4 Hard Disk Drives (3)
B Desktop SYSTEM (C:) DATAL (D) DATA2 (E)
8 Downloads — —  em— —
% Recent Places 7.8 GB &P 134 66 free of 165 GB
-
«4 Libraries
"% Documents
o Music
&=/ Pictures 4 &
B Videos Type Local Disk
Fle system:  NTFS
1% Computer 1 &
ol SYSTEM (C:) [l Free space 25.046.151.168bytes  233GB
s DATAL (U;
ca DATA2 (E) Capacty 73402363904bytes  683GB
G* Support (\\192.168.0.110\ts24corp) (N:)
€ Network
OnveC
[7) Compress this drve to save dek space
[¥] Alow fles on this drve to have contents indexed in addeion to
Hie properes
T | =
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2. Tuy chinh d0 phan giai man hinh:
a. Poi vGi hé diéu hanh Windows 7, 8:

Ngoai man hinh Desktop, nhap chudt phai chon “Screen resolution”.

View DI

Sort by »
Refresh
Paste
Paste shortcut ' N
Undo Rename CtrieZ ‘
Graphics Properties...
Graphics Options »
&) SVN Checkout...
&  TortoiseSVN »

& Groove Folder Synchronization »

Trong clra s6 méi hién ra, 8 muc “Resolution” nhap vao mii tén tré xudng, kéo thanh trugt chon
d6 phan gidi man hinh phu hgp > nhap chon “OK" dé luu lai thiét Iap.

ofi « All Control Panel Items » Display » Screen Resolution - l L3 | Search Controt Panet

Change the appearance of your display

'GSI e |

Osply  [LHPLITO o]

IResolwon: I 1280 x 1024 (recommended) v]

Orientation: High

o 1280 x 1024 (recommended)
Advanced settings
Make text and oth

What display setti
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b. P6i véi Windows 10:
Ngoai man hinh Desktop, nhap chudt phai chon “Display settings”.

View >
Sort b >

Y |
Refresh
Paste

Paste shortcut

Undo Rename Ctrl+Z

&) SVN Checkout...
@ TortoiseSVN

(5] Shared Folder Synchronization
& Adobe Drive CS4

AR VARV R4

| New

| =1 Display settings
& Personalize

Trong clta s “Customize your display”, nhdp chon vao hang chir “Advanced display
settings” > hién bang tuy chinh d6 phan gidi cho man hinh, trong phan “Resolution”, chon do
phan giai tuong Ung, Iuu y hang théng tin ndo hién thi chir "Recommended” & d& phan giai phu
hgp nhat cho cdu hinh may tinh hién tai cila ngudi dung, nhap chon “Apply” sau khi hoan tat.

Customize your display

Identify Detect

Change the size of text, apps, and other items: 100% (Recommended)

Orientation

| Landscape v l

I Advanced display settings h
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1440 x 900 (Recommended)
1366 x 768

1360 x 768

1280 x 1024

1280 x 960

1280 x 800

1280 x 768

1280 x 720

1280 x 600

I
|

Identify Detect

Resolution
1440 x 900 (Recommended) v
Apply Cancel

3. Tuy chon khu vu'c, ngon ngir, viing mién:
Trong hé diéu hanh Windows 7, 8 va 10, trén ban phim nhan chon t& hgp phim “Windows + R”
dé md clra s6 “Run”.

F10 F11 F12

Backspace




n

Nhap Iénh “control” vao 0

“Open” > nhap chon “OK".
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"7 Run

- e

i

Type the name of a program, folder, document, or Internet
resource, and Windows will open it for you.

%' This task will be created with administrative privileges.

Cancel

T |

] [ Browse...

Tuy theo ché& dd hién thi “View by” cua cira s6 “Control Panel” trén mdy tinh ma ngudi dung
chon mé chic nang “Regional and Language” (d6i véi Windows 7) hodc “Region” (d0i vGi
Windows 8, 10).

1) 2)

OQ @ » Control Panel » All Control Panel Rems »

Adjust your computer’s settings

W Action Center £ Adeministrative Tools

W Backup and Restore B BitLocker Drive Encryption
@ Credential Manager <9 Date and Time

% Desktop Gadgets & Device Manager

— Iz e
()= » Contrtpanel »

Adjust your computer's settings

v System and Securi
@ -

3 AutoPlay Lavpa coes,
©  Smallicons.
B Color Mansgemes J

© Oefaur Programs.

& Devices and Printess

d shaning options

+ 9 |[ Search Contret Pane ol
|° Category
User Accounts Large icons
% Change account type Smellicons

Appearance and Personalization
Change the theme

h

W Display © Ease of Access Center Flash Player = =
& HomeGroup &, Indesing Options D) intelR) GMA Driver ﬁ' e and prnters P npetapiiongige
©) Internet Options. (e sova & Keyboard Ease of Access

2 Location and Other Sensors @ i P Mouse o @ ‘c?" indo n'._u.,uq;’,».‘z settings

38 Network and Sharing Center 2 Notfcation Area kcons B Pedormance information and Tools

@ Power Options
& Recovery

B Reattek HO Audio Manager

18 Remterpp and Desktop Connections @)+ » ConvPone » Gk Lagurpe, s Pogen S5 .

@® Syne Center

Control Panel Home

System and Secunty
Network and Internet
Programs
User Accounts
Appesrance and
Personaiaston

* Clock. Language. and Region

Ease of Access

M Windows Defender @ Windows Fuemal

Region and Language

Kiém tra va thiét 18p nhiing thdng tin mdc dinh sir dung sau:
Tab “Formats” > “Format” > chon “English (United States)”.
(S

& Region and Language

Formats | Location | Keyboards and Languages | Administrative |

Format:

|English (United States) -

Date and time formats
[dd/MM/yyyy
|dddd, MMMM dd, yyyy

Short date:

Long date:

Short time:

[h:mm tt




Nh&p chon “Additional settings...” dé thiét 1ap riéng cho phan viing vira Ilua chon.
Tab Numbers, thiét Iap mdc dinh theo qui tac sau:
Decimal symbol: “.” (dau cham)
Digit grouping symbol: *,” (d&u phay)
Negative sign symbol: “-" (dau trlr)
s e (X

-
=]
3
o
i24

[English (United States) -

Date and time formats

i|  shortdate (dd/MM/yyyy o
Long date: dddd, MMMM dd, yyyy -
Short time: [h:mm tt ']
Long time: [h:mm:ss tt ']
First day of week: [Sunday ']
What does the notation mean?

Examples

Short date: 10/09/2015

Long date: Thursday, September 10, 2015
Short time: 1:59 PM

Long time: 1:59:29 PM

Additional settings...

Go online to learn about changing languages and regional formats

[ ok ][ cance ][ oply

¥ Region and Language o)
Fomats | Location | Keyboards and L | Admini

& Customize Format

" — e
Iw'berslonu\:ylm | pate |

Example
Positive:  123,456,789.00 Negative: -123,456,789.00
IDecimal symbol: . v I
No. of digits after decimal: 2 ~|

I Digit grouping symbol: . - I
Digit grouping: 123,456,789 \/

I Negative sign symbol: - - I
Negative number format: [-1.1 ']
Display leading zeros: [0.7 ']
List separator: . -
__’. Measurement system: [U.S. ']
Standard digits: [012456789 ']
! Use native digits: [Nevu ']

Click Reset to restore the system default settings for
numbers, currency, time, and date.
(o ] Aoy

TS24pro
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Tab “Date”, thiét ,Iép dinh dang ngay thang trong muc “Short date” mac dinh theo cdu tric
dd/mm/yyyy, c6 thé nhap truc ti€p vao néu trong bang khong cé thong tin nay.

& Region and Language =
[ Fomats Lmlwmmlm )
L
“ Customize Format
| Numbers lCuvency [ Time
Example
Short date: 10/09/2015
Long date: Thursday, September 10, 2015
Date formats
Short date: dd/MM/yyyy v
Long date: dddd, MMMM dd, yyyy v
What the notations mean:
d, dd = day; ddd, dddd = day of week; M = month; y = year
Calendar
When a two-digit year is entered, interpret it as a year between:
1930 and 2029
| First day of week: | Sunday M
—
Click Reset to restore the system default settings for Reset
numbers, currency, time, and date.

Tab “Location” > “Current Location” > chon “United States”.
'8 Region and Language E‘

_MWNWIWe

Some software, including Windows, may provide you with additional content
for a particular location. Some services provide local information such as news
and weather.

Current location:

United States v

Nh&n chon “OK"” dé& hoan tat viéc thiét Iap.

4. Tuy chon kich c@ font hién thi:
a. Pai vGi hé diéu hanh Windows 7,8:

Tai man hinh Desktop, nhdp chudt phai chon “Personalize” > “Display” > “Smaller (100%)",
kh&i déng lai may tinh dé€ ap dung cho thay déi nay.
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8 « Appesance and Personaiaation » Personsization

Contret Panel Home
Change the visuals and sounds on your computer

Change desktop ions Click a theme to change the desktop background, window color, sounds, and screen saver all at oace.

Change mouse ponters My Themes 1) =)
ST _ o I -
1 o 145 1] o olPoce
- : r'::. )=/ » Control Panel » Appearance and Pesonaication » Doplay [} seord e »
St by » ;b o
A | i i Make it easier to read what's on your screen
O, Vou can change thesice of text and cther tems on your screen by chooring cne of these cptions. To
Paste asoved Thosa temporaniy eniarge ust port of the screen, e the a0t took
Paste sthortcut % Calbrate color
Change daplay setts
Undo Rename ez AveTrames 0 B © Smaller - 100% (defouk) Preview
Adjust CearType et
Graphics Properties... Set custom test size (OPD)
Graphics Options > Medium - 125%
&) SN Checkout - ‘
& Torones , [ J Larger - 150%
2 Groove Feider Synchveniaaton > Windows? Archtecture
= ' o TN =N
B Screen resolution
- e
& Personsice — Dugpley "yt —_—
- tat Menw Desitop Back nd Wndow 3 |

Personalaation
Devsces and Proters

b. D6i vG8i hé diéu hanh Windows 10:
Ngoai man hinh Desktop, nhap chudt phai chon “Display settings”.

View >
Sort by >
Refresh

Paste

Paste shortcut

Undo Rename Ctrl+Z
gtl SVN Checkout...
@ TortoiseSVN

(5] Shared Folder Synchronization
& Adobe Drive C54

AR VAR VARV

New

I =1 Display settings |
& Personalize

Tai clra s& “Customize your display”, thdng tin “Change the size of text, apps ...” mic dinh
la 100% thi gilr nguyén, néu dd hién thi cao hon thi tuy chinh lai vé méc dinh, luu y kich c& font cé
thém chir "Recommended” bdo hiéu d4 la kich c¢& chuén hién thi font chir ctia may tinh, nhdp chon
“Apply” sau khi hoan tat.
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Customize your display

Identify Detect

Change the size of text, apps, and other items: 100% (Recommended) |

Orientation

‘ Landscape v

Advanced display settings

5. Kiém tra cai dat 'ng dung .Net Framework 4.5
Doi véi mot s6 may tinh con s dung hé diéu h%mh Windows XP, q”én thuc hién cai dat b6 (ng
dung .Net Framework 3.5 trudc, sau dé mdi co thé cai dat bd san pham TS24 Professional.
Tai g6i cai d3t tai website TS24.com.vn > “Tai v&” > ndi dung “Phan mém hé trg”, nhap chon
tai gdi cai dat vé may tinh dé& thuc hién cai dat.
™ Taivé x +
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Lu y: doi vdi ung dung .Net Framework 4.5 yéu cdu kiém tra va cai dét thém trén hé diéu hanh
Windows 7, 8, tur hé diéu hanh Windows 10 da tich hgp san phién ban uhg dung nay trong hé thong.

6. Mot s6 phan mém dung kém theo dé h6 trg ngudi dung trong qua trinh sir dung
TS24Pro:

Microsoft Office 2007 (hoac m@i hon): b6 (ing dung vdn phong dé soan thao van ban, bang
tinh, trinh chiéu . . . ho trg luu file dinh kém theo dang *.docx hoac *.xlsx

B6 g6 Unikey: hd trg ngudi dung déanh tiéng viét theo chuan Unicode.

Acrobat Reader (hodc Foxit Reader): (ing dung hd trg xem file *.pdf

CutePDF (hodc mét vai (rng dung cé chifc ning tuong tu): hd trg tao file *.pdf dé dinh
kém chung vdi td khai/ho sa.

May Scan (hoic thiét bi cé chirc nidng tuong tu’): hd trg ngudi dung sao chup lai ching tir
bén ngoai, dua vao may tinh dé dinh kém ndp chung vdi t& khai/hd sG.



